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Jewellery Stylist:
My website’s name is www.jewells.com. It is about jewellery.
Jewelry , what you wear and how you wear it is a personal statement. It can say so much about you, before you have even spoken.
It is based on six webpages.

Introduction to Dreamweaver CS3
Dreamweaver CS3 is the first version of Dreamweaver released by Adobe - Adobe recently bought the original makers of Dreamweaver: Macromedia. 
So what does that really mean for us lowly Web-nerds?
In a nutshell:
· Dreamweaver now works better with Photoshop. 
· Dreamweaver looks more like Photoshop. 
... So if you know Dreamweaver or Photoshop, learning the other should be a little easier. On top of that, it should be easier to use either program since the user interfaces are now similar. 
Any new features/capabilities?
Beyond enhancing/polishing the features that have been around for a while, Dreamweaver CS3 includes a few new things that are kinda interesting:
· Spry framework for Ajax
· Adobe Photoshop® and Fireworks® integration
· Browser Compatibility Check
· CSS layouts
· CSS management
... And that's just sample. 
Is Dreamweaver CS3 a worthy upgrade?
I would have to say yes. 
I've been using Dreamweaver since it was in early beta (this is before version 1) and haven't looked back since. Along the way though, some upgrades were more worthy of others. But this time, Adobe did a good job fixing a few things that bothered me about previous versions of Dreamweaver. 
... I won't get into details right now, but I can tell you that Dreamweaver CS3 is polished. I will be covering more about CS3's new wingwangs in videos and tutorials over the next little while.
For now though, you can read an overview about Dreamweaver CS3, taken from the horses mouth:
Dreamweaver CS3 Overview
Create rich web content
Create rich, dynamic interfaces that tightly weave static structures together with responsive interactivity. Use the new Spry framework for Ajax to develop energetic web experiences that will leave your competition standing still. In other words, think deep, dream big, and then execute flawlessly with the most exciting web design and development tool we've ever devised.
CSS management
Easily move CSS code from inline to head, from head to external sheet, from document to document, or between external sheets. Cleaning up existing CSS in older pages has never been easier.
CSS layouts
Easily incorporate CSS into your project with the new CSS layouts. Extensive comments in each template explain the layout, so beginning and intermediate designers can learn quickly. Each template can be customized for your project.
Maximize efficiency
Accelerate your workflow with Dreamweaver CS3, a faster, smoother version of the preferred web design and development tool. Drop in FLV files, add images from Adobe Photoshop, and test your content for mobile devices. Create visually or code directly, work on your choice of Macintosh or Windows, and enjoy the benefits of intelligent integration with other Adobe tools.
Apply best practices
Dreamweaver CS3 makes it easy to apply best practices and accepted standards to ensure your websites and applications play well with others. Build CSS-based websites from the ground up with new CSS layouts, the unified CSS panel, and CSS visualization and management tools. Ensure more reliable and consistent performance with the new Browser Compatibility Check. Instantly preview your content for PCs, mobile devices, and print, and find fast solutions to browser-specific CSS issues with the new CSS Advisor website.
Web designers
Discover an exceptional web design workflow with Adobe Dreamweaver CS3 software. Design and maintain websites from start to finish with your choice of either a powerful visual design interface or an efficient coding environment. Streamline design with helpful CSS features; preview your pages for PCs, mobile devices, and print; and easily test pages for browser compatibility. Enjoy tight integration with Adobe Photoshop CS3, Flash CS3 Professional, Fireworks CS3, and other Adobe tools.
Web developers
Develop more reliable, consistent web applications based on universally accepted development standards with Adobe Dreamweaver CS3. Take advantage of support for leading web development technologies, including PHP, Adobe ColdFusion, and Ajax, for both internal and external projects. Ensure consistency with helpful CSS features and automated cross-browser compatibility testing.
Industry-leading tool
Take advantage of all the flexibility and power of a world-class web design tool. Manipulate pixel-perfect designs in Design view, craft complex code in Code view, or do a little of each. Work the way you work best.
Integrated workflows
Design, develop, and maintain content within Dreamweaver CS3 while taking advantage of intelligent integration with other Adobe tools, including Adobe Flash CS3 Professional, Adobe Fireworks CS3, Adobe Photoshop CS3, Adobe Contribute CS3, and new Adobe Device Central CS3 for creating mobile device content.
Complete CSS support
Discover the advantage of visual CSS tools that make it easy to view, edit, and move styles within and between files, as well as see how your changes will affect the design. Accelerate your workflow with new CSS layouts, and test your design with the new Browser Compatibility Check.
Integrated coding environment 
Organize and accelerate your coding with code collapse, color coding, line numbering, and a coding toolbar with comment/uncomment and code snippets. Apply code hints for HTML and server languages. 
Support for leading technologies
Take advantage of support for leading web development technologies, including HTML, XHTML, CSS, XML, JavaScript, Ajax, PHP, Adobe ColdFusion, ASP, ASP.NET, and JSP.
Effortless XML
Quickly integrate XML content using either XSL or the Spry framework for Ajax. Point to an XML file or XML feed URL, and Dreamweaver CS3 will display its contents, enabling you to drag and drop appropriate fields onto your page.
Adobe Flash Video support
Easily add Flash Video to your web pages in just five clicks, with no knowledge of Flash required. Customize the video environment to match your website.
Learning resources
Learn as you go with comprehensive in-product tutorials, reference content, and instructional templates that make it easy to expand your skill set and adopt the latest technologies.
Extended Dreamweaver community
Enjoy all the benefits of the extensive Dreamweaver community, including the online Adobe Design Center and Adobe Developer Center, training and seminars, developer certification programs, user forums, and more than 1,000 downloadable extensions available in the Dreamweaver Exchange.
Cross-platform support
Pick your platform: Dreamweaver CS3 is available for Intel or PowerPC based Macintosh computers, as well as for Windows XP and Windows Vista systems. Design in your preferred platform and then deliver across platforms with more reliable, consistent, and high-performance results.
Browser Compatibility Check
Save time and ensure a more consistent experience across browsers and operating systems with the new Browser Compatibility Check. Generate reports that identify CSS-related issues in a variety of browsers, without needing to launch the browsers.
[bookmark: _GoBack]Spry data
Integrate data into web pages using XML from an RSS feed or a database. Integrated data can be easily sorted and filtered.
Spry widgets
Easily add common interface components such as lists, tables, tabs, form validation, and repeatable regions to web pages with widgets from the Spry framework for Ajax. 
Spry effects
Easily add visual transitions to page elements to make them grow, shrink, fade, highlight, and more with the Spry effects for Ajax.
Quickly and easily design, develop, and maintain websites and web applications - from start to finish - with Adobe Dreamweaver software. Built for both designers and developers, Dreamweaver offers the choice of working in an intuitive visual layout interface or a streamlined coding environment. 
Intelligent integration with Adobe Photoshop, Adobe Illustrator, Adobe Fireworks, Adobe Flash Professional, and Adobe Contribute software ensures efficient workflow across your favorite tools.
Dreamweaver CS3 Video Tutorials
The following set of videos are from my new course: 'Beginners Dreamweaver CS3'. Targeting total beginners, I assume that you need to be taught the basics of not only Dreamweaver CS3, but basic web design concepts as well.
By the end of the course, you will feel comfortable using Dreamweaver CS3 to build modern websites.
	Before you create your webpages, begin by creating a folder that will contain your entire website. Go to the File menu and from the drop down menu select "New Folder.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/name_new_f_jpg.jpg]
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	For this this exercise, click on the "untitled folder" and let's name our folder (sometimes called a "Directory") "my_web_site"
It is important as a rule-of-process, to always name folders, webpages and images with lowercase text and no spaces in their naming.
Other text that is not usuable in naming pages, images and folders are: [ !,-,@,#,$,%,^,&,*,(,)?,/,<,+,= ]

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/insert_images_f_jpg.jpg]
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	Open your "my_web_site" folder and create a new folder and name that new folder "images". The purpose of creating subfolders (sometimes called "sub-directories") are to hold specific files in our website. 

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/name_images_f_jpg.jpg]
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	Once we create and import images for our web pages, we will save those image files here. The purpose of these subfolders is to ensure better organization of your files.
 

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/etc_folders_jpg.jpg]
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	Other types of subfolders that you may eventually include will be folders for your music, animation, and printable document files called pdf's.
Again the main reason for these subfolders is so you may organize your contents.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/site_menu_jpg.jpg]
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	Now we can create our "Site" within Dreamweaver. Go to and click the Menu tab labeled "Site". From that drop down menu, select "New Site"

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/site_setup2_jpg.jpg]
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	You should see a dialogue box appear, make sure the "Advanced Tab" is highlighted. Your instructor may opt to take you through the "Basic" tab sittings at first.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/define_site_jpg.jpg]
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	First we give our site a name (usually best to name the site the same as our folder we created earlier, except in this case you may have spaces). 

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/choose_localroot_jpg.jpg]
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	Next we select the destination of our local root folder. This is the folder we just created for our website. Dreamweaver will assist us in managing our site. Click on the folder icon to right of lable for Local Root Folder: and navigate over to where you saved your "my_web_site" folder, click on that folder and then say choose.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/folder_for_site_jpg.jpg]
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	In the future, you may create your website folders with this option within the site manager.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/create_images_f_jpg.jpg]
9b 
	As well as Images folder and other sub folders may be created through site management options.
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	When you have finished defining your site, this is what you should see in your site manager.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/new_file_jpg.jpg]
11 
	Now lets create a blank web page to begin our work. Within Dreamweaver, go to "File" and click. From the drop-down menu select "New"

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/new_doc_html_jpg.jpg]
12 
	You will see a dialouge box that asked what sort of work you are doing. In this case make sure Basic Page and HTML are high-lighted and then click on "Create"

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/file_save_as_jpg.jpg]
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	Next we need to be in the practice of before we begin our work, we should always name and save our files. Since this page will serve for now as our "Home Page" we always name our home page the "index" page. This is because when someone goes to your website, as in your case, "my_web_site". Their Internet browers looks for the "index" page as the first page. So save this page with the name index.html.
Save this index file to your site folder "my_web_site"

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/site_with_index_jpg.jpg]
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	You should see this in your site manager. If your "Site" manager window is not open, just as when you created your site as in Example #6, Go to the "Site" menu, and select "Open Site" and then select "My Web Site" from the list and you can see the Site Manager. From this list you may select any file. Select the index.html file if it is not already open on your desktop.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/what_u_should_see_jpg.jpg]
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	When we see our index page (homepage) we can now give our website a title. 

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/doc_title_jpg.jpg]
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	Click within the "Title" box and give your website a greeting, such as "Welcome to my website", that would include your name or name of materials convered in the website.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/your_name_here_jpg.jpg]
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	It should look something like this in the Title Bar
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	We could begin entering information on the index page as it is now. Yet to better organize information on your page, let's insert a table with a specific size and begin there to format our web pages.
Go To the "Insert" Menu item and then on the drop-down menu, go to and click "Table"

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/insert_table_jpg.jpg]
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	You should see a dialogue box that contains information about the Table you wish to insert. As you can see we have several options. For this exercise, lets create a table with 1 (one) Row, 1 (one) column, "fixed" at 640 pixels option, 0 (zero) border, and 0 (zero) cell padding. Once you become better aquainted with web page layout, you will want to utilize these options at a later time.Choose "OK" when you have finished.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/table_size_jpg.jpg]
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	Once you have inserted a Table, you have several options from your "Properties" Window. If you do not see your "Properties" Window, go to and click on the Window drop-down menu and click "Properties. The table has to be high-lighted (as on the left) to utilize the Properties window. Now you may work with the available back ground and border colors.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/border_color_jpg.jpg]
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	To choose your table, use the arrow tool to high-light the table. To make changes in table colors, use the "Properties" Toolbox display from the Menu "Window" to adjust "Brdr Color" for Border Colors.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/border_size_jpg.jpg]
22 
	To adjust the Border sizes, select the table and change the number within the "Properties Menu. To have a table without borders, input "0" zero.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/bkgd_color_jpg.jpg]
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	To choose your table, use the arrow tool to high-light the table. To make changes in table colors, use the "Properties" Toolbox display from the Menu "Window" to adjust background colors choose "Bg Color" and select from the color menu.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/table_alignment_jpg.jpg]
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	Before you place text or images in your table, click in your table with your curser and select the appropriate alignment from the Properties Window". Depending on how you plan to create your page, you may choose from "Left, Center, Right". Default settings may be to the left. In the case of this exercise, choose the "Left" setting.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/text_options_jpg.jpg]
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	You may now type in or paste text from another document (i.e. - Word, or html) into your table. High-lighting the text gives you the option to change the colors of the text within the "Properties Box"

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/text_color_jpg.jpg]
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	For Bright backgrounds you need to choose a light colored text, or better yet, rethink your color schemes for your backgrounds.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/bad_text_jpg.jpg]
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	When using colors for text and table, be sure that you used colors that are high in contrast versus colors that are similar.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/good_text_jpg.jpg]
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	This is a more appropriate way to set your table and font colors. It is best to use high contrast when displaying text in a web page. You may also try light-colored text on a dark back ground.
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	Now lets insert an image into your website. Click your curser into the table you created.Go to "Insert: Menu and in the drop-down, click on Image. 
You may need to either scan an image or seek a copyright free images from the Internet. If you scan an image, or take one with a digital camera, the resolution of the image needs to be 72-100 dots per inch (dpi) to work on the Internet correctly.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/insert_media_jpg.jpg]
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	Addtionally if you want to insert other media, this is the same procedure, just go to the "Media" drop-down item and choose the appropriate media, (i.e.) Flash animation.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/image_select_jpg.jpg]
	To continue with Image Insert, you will have to navigate to where you have your image saved. Sometimes it is best to save the images you will use in the "images" folder within your site. Dreamweaver will ask you if you want to save it there, if you have not.
Select the image you have saved and say Choose.
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	Once the image is chosen, it will be placed it into your table, to the left, right, or center, depending on how you have set up the alignment (see example 24).
You need now to name your image. Click on your image, the "Properties Box" changes depending on what is sellected. In the right upper corner is a section for "ALT" In that box, name what the image is. This option is for those that use the Internet with disabilities and may be unable to see images. This option alloys them to hear what the image is. If it is not assigned a name, the person using ALT tags will only here, "Image". It is a good policy to learn to add Alt tags to your images and Hot Spots for Persons under the American Disabilities Act (ADA)

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/image_site_map_jpg.jpg]
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	Once your image is added to your website, it should show up in your site manager as shown here.
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	If we would like to make a Hot Spot over an image so we can add a Link to another site. First high-light the image. Next from the lower left side of the Properties Box, select the appropriate type of Hotspot (Squares, Circles, Polygons) and draw a Hot Spot over your image. 
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	Again you have to name your Hot Spot in the Alt Tags Box. In this case, "The Washington Monument" is the appropriate text. Next you need to add the link to the external website. In this case it is http://www.nps.gov/wamo/home.htm
Once you have done this, you can test your link by going to "File" to the drop-down menu to "Preview in Browser", and select the Browser. A temporary copy of your webpage will be displayed and you can test your links.

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/images2/thumbnails/new_doc_html_jpg.jpg]
	To create a link to another page in your site. First you must create a new html document, just as was done for the "index" page. This time you may name the new document as you wish, just remember:
It is important as a rule-of-process, to always name folders, webpages and images with lowercase text and no spaces in their naming.
Other text that is not usuable in naming pages, images and folders are: [ !,-,@,#,$,%,^,&,*,(,)?,/,<,+,= ]

	[image: http://www.ncsu.edu/viste/how_to_use_DW/images/internal_link.jpg]
	To create a link between two pages, we shall look at the example (top of the page) of how the Vocabulary Page is linked to this page. Here is the sequence.
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